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An introduction to everything 
From golf cart to Mars Rover 

It’s moving day, and you’re waiting for your friend to arrive with a truck. 
Since you’re a typical journalist, you have only a few sticks of furniture, several 
dozen egg boxes filled with old textbooks and two cartons of Ramen noodles. 

But instead of the small U-Haul you expect, here comes your friend driving a 
22-ton, 14-speed stick shift behemoth, with enough interior space to move an 
orchestra, grand piano included. The truck clips utility poles and silver maples as 
your friend tries to negotiate down an alley built to accommodate wheelbarrows. 

Welcome to CCI! As we trundle through the many features and uses of this 
new pagination and story system, you will be pleased we are finally getting some 
helpful software for the 21st century. But sometimes, as you consider the 
magnitude of the new system, you may think, we didn’t need this much help. 

Comparing old and new 
The CCI system is incredibly powerful and flexible, but as you can expect 

with any machinery that does a lot of dissimilar tasks, CCI is much more complex 
than anything we currently use. 

For comparison, let’s try a simple metaphor. We can think of our Triple-I 
stations as separate bookcases. A Triple-I story can be thought of as a book with 
the slug being the binding of the book – what we see before we open it. 

 

The only thing on the binding of each book is the name, page and date of 
publication. The book goes from bookcase to bookcase along its journey to being 
published. The way you know the editing state of each book is by the location of 
the book. If it’s in the METDLY bookcase, it’s ready to be designed. If it’s in IN 
@ IN, it’s ready to be copy edited.  
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So what happens if you put a book on the 
wrong bookcase? You’re outta luck, mister. 

Now, think of CCI as one gigantic 
bookcase the size of city block. Every book in 
the system is located on this one huge 
bookcase. Each new book is merely added to 
the end of the bookcase or stuffed wherever 
there’s space somewhere in the middle. 

But how can you find the story you need? 

Two great CCI features 
CCI does two things that help us in this 

task: 
First, the “binding” 

of the books in CCI have 
an incredible number of 
attributes, much more 
than just name, page and 
date.  

Each story in CCI has multiple fields 
for not only name, date and page, but 
also for the creation date, the creator, 
the last edited date, the length, the last 
user, the current user, the content desk 

(such as metro or sports), the edition, the editing state (Has it been copy edited?), 
the head-and-fit state (Has a headline been written?), the type of content (Is it a 
story, photo or graphic?) and many, many more.  

In fact, many of the categories that CCI provides we won’t even find useful. 
But they’re there, in case we need them in the future. 

Second, CCI gives users what we could call special goggles, or list windows. 
These list windows narrow down the number of stories you 
see at one time. For example, there are windows called Wire 
Categories, Copy Editor and Source Editor. (Source editor is 

the term CCI uses to describe those who edit stories written by the reporters, such 
as a metro editor.)  

But many of the list windows are smart: they know who you are, what 
publication date you’re working on and what department you’re with and give 
you a window that reflects those facts. Each department will have a Source Editor 
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window, and each department will see only stories marked as belonging to your 
department. 

(My fellow nerds may have already put two and two together and know that 
such a storage system is called a database. If you’re familiar with Microsoft 
Excel, you know the database’s cousin, the spreadsheet. One big difference is that 
the database is absolutely more rigid in how the fields – that’s the rows and 
columns – are organized. For this purpose, that rigidity is essential.) 

So, put together the fields and the list windows, and you get a powerful way 
of organizing and manipulating data. 

Here’s an example 
A reporter comes up to you and says he filed his story, but he doesn’t know 

where he filed it or what it’s called. 
Well, that’s a 

tough task in any 
situation, but at least 
with CCI there is such 
a thing as a creator 
field. You can click on 
this field in a window 
called the budget, do a search on the reporter’s name, select the story, send the 
story to the right place, and knock the reporter on the head for being careless. 

(OK, that last part is an add-on for editors and not a part of the 
CCI system.) 

Tidbit 
You’ll find these “Tidbit” 
boxes littered throughout 
this book. It will contain 
particular nuggets of 
information that you may 
find helpful on your quest 
to CCI competence. 

It’s like the books have little flags that say, “Me! Me!” and all 
you have to do is perform the right search or open the right 
window to find them. 

So here’s the CCI system. It’s more than we need – and trust 
me, we who have been working with the system have already 
deleted some functions that would just make your head hurt – but 
it will do what we need it to do: Keep track of all of our stories, 
photos, graphics, headlines, cutlines and marginalia and pop it out 
in some form that resembles a newspaper. 

And it’s not Triple-I. Goodbye NET ACK, and good riddance. 
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Logging in 
Yes, an entire chapter on logging in 

There’s more to logging in than you may have guessed. When you double-
click the CCI NewsDesk icon on your desktop, this window will greet you: 

In the CCI Login window, enter your user name, password and group name. 
Or use the pull-down menu on the right to choose a group name.  

Your group name is a definition of your job duties: Reporter, 
Copy Editor, Designer, etc. You may have more than one to 
choose from. If a copy editor also does some design, that copy 
editor may have both the Copy Editor and Designer group names. Tidbit 

Notice that many of the fill-
’em-in fields in CCI are 
case-sensitive — typing 
in “reporter” doesn’t work 
when CCI is expecting to 
see “Reporter.” 

This group name helps CCI know what list windows to show 
you. A reporter would want to see different list windows than a 
designer, for example. 

Also, notice that here you can change your password by 
clicking the Password… button and following the instructions. 

This opens the Set Login Info window (see the next page): 
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The Set Login Info box 
Pause and consider the 

importance of this window.  
Here you set the default work 

settings while you are working in 
CCI. You’ll be able to change t
settings once inside CCI, but hey, 
it’s easier to get them right the first 
time. 

hese 

Let’s step through these fields 
one at a time: 

Product: This will most likely 
be NS, for the broadsheet News-
Sentinel pages. But CCI is peculiar 

on tab pages: It insists on having tab sections as separate products. So if you 
know you’ll be working exclusively in Ticket!, Business Monday or PrepSports, 
select the appropriate product here. 

PubDate: Unless you enjoy losing your stories, use the date of the upcoming 
newspaper as your publication date. Working a Tuesday morning? Choose 
Tuesday’s date. Working a Sunday afternoon? Choose Monday’s date. 

Layout Desk: There are two. Almost everyone will select Design, except for 
the editorial department, which will select Editorial. 

Content Desk: Ah, this is important. Be sure to select the correct department 
here: Metro, Sports, Business, Features or News. Copy desk, design desk and 
news desk personnel should choose News. 

Zone: We have no zones. Select Zone. 
Edition: Keep it simple. Select First. Later, you can always go Home. 
Mapword: This is a new concept. The major purpose of mapwords is to make 

sure the stories you write end up in the right place on the Web. For now, just 
select General for Mapword 1. 

Click OK and CCI NewsDesk will start. 
So you know, it takes a while to load. Go grab a coffee and 

come back for the next chapter. 

Logging off 
When you’re all done and ready to go home, simply go to the File menu of the 

DB Access control window (see the next chapter) and select Exit and Logoff at 
the very bottom of the menu. 
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List windows 
The remote control for CCI 

Your windows into the wonderful world of CCI are the list 
windows, each one calibrated to let you see certain types of 
information. 

But there are so many different types of list windows that 
you need a control window to keep track of them. This control 
window is called DB Access (DB stands for database): 

Each big rectangular button represents a list window.  
Your actual buttons may vary. But that’s OK; you can always add or remove 

buttons when you need to. 
To remove a button, just right click on any button and a little 

menu pops up. Select Remove List Window from the menu, and 
the button disappears. 

Do you want that button back? Click on the File menu, select 
Add List Window and choose from the substantial list. 

The name CCI gives these buttons is notify buttons. That’s 
because, by their color and the symbols they display, the buttons 
tell you of changes in the list window. 

If the button is gray: The window is closed. 
If the button is green: The window is open or hidden. 
Symbols called revision marks appear on the buttons to tell 

you what has happened in the window since you opened it. The three symbols 
we’ll deal with for now are: 

Tidbit 
Better get used to right 
clicking. You will 
frequently do the task you 
need to do by right clicking 
and selecting from a pop-
up menu. 

A plus sign +: There’s something new in the window. 
A minus sign -: Something has been moved or deleted from the list window. 
A tilde ~: Something in the window has changed. 
Every time you double-click the green button, the revision marks will be 

cleared and the button will be able to show you the presence of more updates in 
the list window. 
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Your first list window exercise (wow!) 
Click on the WireCategory button in the DB Access control window. (If the 

button isn’t there, do you know how to add it?) Select a category from the 
window: 

You will then see your window into the wires: 

There’s a lot going on here. Let’s take a tour through this window. By the 
way, what you learn here will be applied to other windows, as well. 

In row A, first thing you see is that green notify button. Hey, that’s the same 
as in your DB Access control window!  

Next is a time stamp. This lets you know the last time you updated your notify 
button by clicking on it. 
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Next is the basket chooser. Remember 
when you selected a particular wire in the 
little window when you first selected the 
WireCategory window? You can see that 
little window again by click-selecting 
WireCategory here.  

Next is the list view selector. Notice the WireCategory list window example 
on the previous page. You see a list of stories and a single story displayed beside 
it. Now see that the list view selector says List and Single. So you can change 
this list view by selecting other views. This doesn’t change what stories are 
displayed, only how they are displayed. 

Now on to row B.  The filter keeps items 
out of your list window. For example, in the 
illustration on Page 8, the filter is marked for 
NotUsed. That means it’s showing you only 
those stories which have not been selected for 
possible use in the newspaper. If you don’t see 
a story you are expecting to see in a window, 
look to your filter. It may be keeping out 
stories you want to see. 

Next is the text filter, which acts like a 
search on all the fields shown in the window. 
Just type in your search request and press 
Enter. Then the window shows you only those 
items that match your search. Delete it and 
press Enter to go back to seeing all the items.  

What if you want to search in only one or 
two of the fields instead of all of them? Right 
click on the title box of any of the fields and 
select Use Field in Text Filter. See the little symbol at the end of the field title 
box? To go back to using all of the fields again, right click on a field title box and 
select Use All Fields in Text Filter. 

Tidbit 
On Page 8 in the 
WireCategory window, see 
the vertical scroll bar just 
to the right of the text of 
the story? You would think 
it would be for scrolling 
through the text of that 
story. But instead, if you 
use that scroll bar, you will 
scroll through the stories 
listed on the left. To scroll 
through the story itself, 
first click in the story’s text 
and another vertical scroll 
bar appears. 

Last is the sort box. A sort isn’t a filter. A sort only rearranges the stories that 
are listed. One sort is –Standard-, which lists in alphanumeric order starting from 
the field on the far left and working to the right. The sort called Creation of 
course lists the stories in order of when they were created, newest story first. 

You can also do an alphanumeric sort upon each of the fields. Click on a field 
title box and see the little stair-step symbol . This symbol tells you it’s sorting 
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in ascending, or A to Z, order. Click again and see a similar symbol . This one 
tells you it’s sorting in descending, or Z to A, order. Go back to normal sorting by 
choosing either –Standard- or Creation from the sort box in row B. 

If there’s a tilde (~) in front of the sort word, what do you think that means? 
Think about what it means in the notify button. 

So you know, the list window can be configured with great 
flexibility. Under the View menu, we can select Define Display… 
and change how the window is split (vertically or horizontally). Under 
the Notify menu, we can change how the notify button and revision 
marks operate. Under the Field menu, we can add or remove fields a
change their order. 

nd 

It all adds up to a dizzying array of manipulations one can do to a 
list window. For now, let’s leave them how they are and continue. 

Your personal spider hole 
Click on the User Basket button in your control window. This User Basket 

is a place for you to store stories that aren’t ready for anyone else to see. (We’ll 
learn how to create stories in an upcoming chapter.) 

Is this a good place to keep your stories? Not the ones that you plan to have 
published anytime soon – no one else has access your user basket. 

Reverting to your default setup 
After all this opening and closing of windows, you may have a big mess on 

your screen. But you can always go back to your standard setup in the DB Access 
control window and all list windows that you had when you first logged on.  

To do this, go to the File menu in the DB Access control window and choose 
Revert to Saved DB Access Setup. This will reset all list windows and the 
contents of the control window. 
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Changing your work settings 
Global changes and local changes 

When you logged on to CCI NewsDesk, you chose your default work settings, 
such as publication, publication date and content desk. If you want to change any 
of those settings, you don’t have to log off and on again. 

You can change these work settings either globally, so all of your windows 
are affected, or specifically for a certain window. 

Set work defaults 
To see the global change, any window will do, but let’s open your Budget list 

window because it will show you everything in the CCI system that corresponds 
to your current work settings. 

Now, right click anywhere in the list window and select Set Work Defaults. 
You will now see the same Set Login Info window that you saw when logging in 
to the system.  

You can change the date or content desk to see a corresponding list in the 
Budget window. But be sure to change it back when you’re done. 

Changing settings for a list window 
You can also change these settings one window at a time. Open your Write 

Basket window and look at the Filter field at the bottom-left corner. 
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Make sure that Live Content Desk Write is selected. This means that you see 
only stories with your current work settings. 

From the Filter field, select the filter Advance Content Desk Write. This 
will show all stories in the Write Basket except the ones for your current 
publication date. (That’s right: In the CCI world, this “advance” filter means 
every other day, not just those days that happen to be in the future.) 

Next, in the Filter field, select Prompt Write. A prompt is a pop-up window 
that will ask you for some information. In this case, it’s asking for the product, 

layout desk, content desk, 
publication date, zone and edition 
information to be displayed in 
your Write Basket window. You 
can choose, say, sports, and take a 
look at any stories in the sports 
department’s write basket. 

Note that in most of these 
prompt windows, you can use an 
asterisk (*) instead of anything 
particular. Anyone familiar with 
good ol’ fashioned searches on a 
computer knows that an asterisk i

a wild card – the computer will give you all results for that field. 
s 

For example, if you put an asterisk in the content desk field, you will get to 
see stories from all of the content desks. If you put an asterisk in the edition field, 
you will see stories for all editions. 

Bonus food for thought 
You can go to your control window and open more than one Write Basket 

window. They operate independently of each other. Considering the filters, can 
you think of a use for having more than one Write Basket open at a time? 
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Story flow 
From shore to shore 

The CCI system groups all of our s
photos and graphics into two grand 
categories which we could call the 
production pipeline and the storage silo. 

tories, 

Work Basket, Source Editor, Copy Editor, Slot Editor and Slotted Stories. 

to w
ries that 

We could, but we won’t.  
Instead, let’s use CCI’s words: Either the story is in the flow – or not. 

In the flow 
Remember that Budget list window you opened in the last chapter? That is 

your window into the flow – that is, into seeing what stories, photos and graphics 
are currently anywhere in the production pipeline. 

The Budget list window shows you a wide-angle view of five work areas: 

The Work Basket list window shows stories that reporters are writing or need 

From the 
Budget list 

window, users 
can see the 

entire flow, from 
Write Basket to 
Slotted Stories. 

User Basket, 
Advance 

Stories and 
Wire Categories 

are among the 
baskets not in 
the flow — so 
their contents 

are not seen in 
the Budget. 

ork on. The Source Editor list window shows stories that have been 
completed by the reporters. The Copy Editor list window shows those sto
are ready to be designed and edited. The Slot Editor list window shows stories 

The News-Sentinel Guide to CCI: An Introduction   Page 17  



that are ready to be slotted and the Slotted Stories window shows … well, you 
can figure it out.  

And the Budget list window sees it all. 

Parallel workflow 
But where are the page designers in all of this? 
Here is where the beauty of the CCI system really blossoms. The designer can 

select the story anywhere along this story flow – the design flow is parallel to the 
copy flow.  

Here, then, is a typical story flow through the CCI system (as adapted from 
CCI training materials): 

 Stories are written by reporters. 
 Stories may be created by source editors, assigned to reporters and 

budgeted. 
 Stories for standing elements such as columns or briefs 

packages may be requested on the basis of a designed page. 
(This is called layout-driven workflow.) 

Tidbit 
If you have fifteen 
windows on your 
screen, how can you 
easy find the control 
window? Go to the 
View menu of any 
window and select 
Show Control 
Window at the very 
bottom —or use the 
shortcut ctrl-shift-c.

 Stories may be written by reporters working away from the 
CCI system – such as at a sporting event – and filed into 
CCI later using a gateway such as a through a Web page or 
via an e-mail address.  

 During the transition period, stories may be written in 
Triple-I and filed into the CCI database (or written in CCI 
and dumped back into Triple-I). 

 Written stories are sent to source editors. 
 Source editors check the stories. 
 Source editors may send stories to reporters for rewrite. 
 When stories are approved by the source editors, they are 

sent to the copy desk where they may be assigned to a copy 
editor by the slot editor. 

 Stories are edited by copy editors and sent to the slot editor. 
 The slot editor checks and approves the stories or returns them to copy 

editors for further changes. 
 In parallel to the copy editing of the stories, designers may assign the 

stories to pages, mount them on pages and finish the design of the 
stories. 

 Designers send stories to copy editors for headlines, captions and fitting. 
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 Copy editors write the headline, captions and other missing elements and 
fit the stories to the layouts. 

 The stories are passed on to the slot editor. 
 The stories are checked by the slot editor and typeset. 

Remember that the stories aren’t really moving from place to place in the 
system, like in Triple-I. Instead, little flags called states are attached to the stories 
and are being changed. The list windows are doing a constant search for stories 
with certain states. 

Here are the 
different 

baskets in the 
flow, along 

with the 
correspondin

g content 
states. 

For example, when a reporter is done with a story, he does an action on the 
story called, simply enough, To Source Editor.  

When this happens, the story doesn’t move. Instead, a little flag called a 
content state changes to Written. The Source Editor list window is on constant 
watch for stories with that content state. So the story, with its changed flag, now 
shows up in the Source Editor list window and not the Write Basket. 

Two additional points about the CCI system should be made: 
It’s flexible enough to allow, say, the slot editor to send a story back to a 

reporter, who can then make a fix and send it back.  
The system also will be simultaneously handling photos, graphics, ads and 

pages, all of which have their own flow. 

Not in the flow 
So, when are stories not in the flow? Anything kept in the following places 

will not show up in the Budget list window: 
Your User Basket (introduced a couple of chapters ago). Actually, 

anything in your User Basket is completely invisible to other users.  
The wires. We’ll talk more about the wires in an upcoming chapter. Suffice to 

say that stories on the wires do not automatically move into the flow. They must 
be copied into the flow to be seen in the Budget. 

Advance stories. These stories also are not in the Budget list window. 
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Writing a story 
Opening your User Basket 

You can create a new story in one of two places: 
Your own private User Basket, which no one else can 
see, or the more public Write Basket, which is shared by you and the rest 
of your department. 

For now, let’s create a story in your User Basket. 

Your User Basket likely looks on lot like the 
above – except with different stories, of course. Notice 
that the large window with the many fields has scroll 
bars – and you have a lot of fields to peruse and, in 
many cases, safely ignore.  

Tidbit 
Double-clicking a 
story in a list window 
in the CCI database 
won’t open the story. 
Instead, you enter a 
database no-man’s-
land. To fix your 
window, click on the 
basket chooser in row 
A of the list window 
(see below). Your 
view will be restored. 

The first field with the asterisk shows the revision 
marks for each story. These marks are then reflected in 
the notify button. 

In the User Basket list window, right-click, and 
select the action Create Story. This will open the 

window to the left. Enter a 
name in the Name field 
and make sure the other 
mandatory fields (marked 
by M) are filled out. Note 
that the suggested values 
correspond to the values 
from your login. Click 
OK. 
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Now you have an empty story in your User Basket. Note that the story is 
listed in the list window. 

Right-click your new story and select Edit to open the story in CCI Edit/MS 
Word.  

CCI hijacks Microsoft Word! 
Yes, it’s true. You will soon see that the CCI flavor of Microsoft Word is 

somewhat different than regular true-blue Word. Its toolbars should look 
somewhat similar to those shown below. 

The bottom two rows of buttons are CCI specific. (Your buttons may appear 
at different places on your toolbar – they will work the same regardless.) The 
buttons with little yellow arrows will save and send your story off to a different 
list window. And the menus that say “Select tag…” are discussed next. 

By the way, I wouldn’t recommend trying to use regular Word while using 
CCI. Word seems to get confused when that happens. 

Tags 
In any typesetting system, from Triple-I to Microsoft Word to QuarkXPress to 

CCI, the computer needs some way of knowing what text is body copy, what is a 
byline, what is a cutline, and what is a headline. And then it needs to know what 
typography – typeface, font size, justification – to apply to body copy, or a byline, 
or a cutline, or a headline. 

Triple-I has no idea in its little pea-brain what text is a headline and what is 
body copy. All those codes in the brackets change what the text looks like, but 
don’t in any fundamental way tell Triple-I that such-and-such is a byline or such-
and-such is marginalia. 

Quark and Word are smarter. In each of these, you can set up styles to apply 
to different portions of text. You can define a headline style and apply it to what 
you know are headlines. Then if you change the style later, the software can 
update the headlines in the text to reflect the changes. 

Similarly, CCI has tags. You can see the available tags in the pull-down 
menus in CCI Edit/MS Word, as shown on the next page. 

Page 22   The News-Sentinel Guide to CCI: An Introduction 



There are four types of tags: 
Element tags – These are the bedrock 

tags. All of your text has to live inside one 
of these tags. Examples include body, 
cutline, cutline_credit, head, byline and 
factbox (which we use to call 
marginalia). 

Paragraph tags – These tags live 
inside element tags and affect an entire paragraph (or more). Examples include 
byline_email (which lives inside the byline element tag), factbox_head (inside 
the factbox element tag) and subhead (inside the body element tag). 

Character tags – These live inside element tags, too, but do not have to affect 
an entire paragraph. They can affect as little as one character. Examples include 

bold and italic and dateline (all inside the body element tag) and 
quote_attrib (inside the quote element tag). 

Macro tags – These are special tags for things such as bullets and 
stars. You will most likely place the three odd characters – arrow, diamond 
and star – into your text using the Symbols pull-down menu, as pictured at 
the left. 

Tagging and untagging 
By default your story has a byline and a body tag. Depending on some presets 

deep within the bowels of the CCI system, your actual name and e-mail address 
may automatically type themselves in the right space. 

If you need more tags, it’s easy to add them.  
To add an element tag, just click somewhere in the story and select the tag 

from the correct pull-down menu. CCI Word will add a new tag space. 
If you select some text first, that text will be placed inside the tag. So, for 

example, if a byline is on the story, but there is no byline tag in sight, just select 
the text of the byline and choose byline from the element tag menu. Groovy! 

For paragraph and character tags, it’s 
best to select the text before selecting the 
tag. So in the example at the left, we selected 
“brown fox” in the text and then selected the 
bold_italic character tag. 

But look at the text in your Word 
document. It’s not necessarily the same size or typeface as our design style 
dictates, although the text of the headline does look like a generic headline. 
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So how will these tags look in print? You can see a proof of your story by 
going to the File menu and choosing Open CCI ProofView – or type F8. Since 
your story hasn’t been placed on a page by a designer yet, you will see only a one-
column proof. 

But ProofView is smart. As the story travels through the flow, anyone opening 
ProofView will see an accurate view of the story as a headline is written, a picture 
is added and a design is implemented. 

Untagging the text is a little trickier, but still manageable. 
To see all the tags in your text, go to the Edit menu and 

select Tags in Text. You’ll see a window like the one to the 
right. Here, you can simply select a tag and either replace it with 
a different one or delete it entirely.  

If you select a tag and click Untag, you do not delete the 
contents of that tag, only the tag itself. The text inside the tag just 
floats inside whatever element tag it finds itself in.  

You cannot delete an 
element tag from the Tags 
in Text box. Instead, just 
stay in the main Word 
window. With your mouse, click-drag select 
the portion of the story that contains the tag 
header and the text within the tag, as shown 
to the left. Then press the Delete key. 

Spelling and grammar 
check 

CCI Word has a very 
good spelling and grammar 
checker installed. Click 
Spelling and Grammar on 
the Tools menu or click F7. 
You will see the box to the 
right. 

If you don’t want CCI 
Word to check grammar, just 
click off the Check 
grammar box at the bottom 
of this dialog box. 
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AutoCorrect 
Another cool feature in 

CCI Word is AutoCorrect. 
Choose AutoCorrect 
Options… in the Tools 
menu to access the box to the 
left. 

When the Replace as 
you type function is c
AutoCorrect notices when 
you type a word that appear
in the first column, like cci, 
and replaces it with the 
corresponding work in the  
second column, like CCI 
Europe. 

hecked, 

s 

lways 

You can type in new 
entries. For example, if you 
notice you often accidentally 
type wayne when you a
want to capitalize it, you can 
put wayne in the replace: 
column and Wayne in the 

With: column. 
Also, if you grow weary of typing Southeast Allen County Schools several 

times a day, you can put sacs in the Replace: column and Southeast Allen 
County Schools in the With: column. Then as you type, AutoCorrect 
automatically replaces sacs with Southeast Allen County Schools. 

Note: Make sure your abbreviation isn’t a word itself, or every time you’d 
type it that word, Bam! The replacement appears. You can delete delete delete to 
return to your original word, but wow that’s annoying. 

Notes 
Refer to CCI docs for this, Jon! 
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Save and Save Public 
What’s the difference between these two? 
First, the difference is seen only when your story is stored in an area where 

others can view it in the database, such as the Write Basket or Copy Editor. That 
is, it must be in the flow. 

Now, if you do a regular Save, the story is saved locally. Period.  
But if you do a Save Public, your story is saved back into the database. You 

still have sole ownership of the story, but now others can see your changes, 
including editors and designers. 

Mapwords 
The purpose for mapwords is to get your story to the right place on The News-

Sentinel web site. Select the appropriate mapwords from the drop-down menus. 
Note that they are smart. If you have selected Features for your content desk, 

the mapword menus reflect features content, such as Entertainment and Food. 
Also, each drop-down menu depends on the one above it. Select Food for 
Mapword 1 and you’ll see Recipes, Restaurant Notes and Restaurant Reviews for 
choices for Mapword 2. Similarly, choose Listings and you’ll see Anniversaries, 
Engagements and Weddings. 

Pass it forward 
When it’s time to send your story to someone else, you have some options.  
You can choose several destinations from within CCI Word, as seen below. 
Also, if the story 

is in your user basket, 
you can send it to 
someone else’s user 
basket. Save your story and right-click on it in your User Basket. Choose To User. 
Then you can choose another user from a drop-down menu. But be careful! When 
you do that, you can no longer access your story. It is sealed tight inside someone 
else’s user basket. 

A better idea would be to send the story to the write basket, where another 
reporter can pick up the story, but where the story is still accessible by others. 
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Reading the wires
Finding the story 

Wire Category list window. 
 
 
 
 
 

Importing and 
exporting 
E-mail your stories and photos 

Text goes into Remote Input. Photos go into Photo Pool. 
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Index 
  
22-ton, 14-speed stick shift behemoth, 5 
  
action, 19 
advance filter, 16 
advance stories, 19 
asterisk (*), 16 
attributes, 6 
AutoCorrect, 25 
  
basket, 13 
budget, 7, 15, 17 
buttons. See notify buttons 
  
case-sensitive, 9 
CCI_In_Basket, 29 
Character tags, 23 
coffee, 10 
Content Desk, 10 
content state, 19 
control window, 11 

finding, 18 
Copy Editor, 17 
creator field, 7 
  
database, 7 
DB Access, 11 

default setup, 14 
double-clicking, 21 
  
Edition, 10 
Element tags, 23 
e-mail, 29 
  
factbox, 23 
fields, 6 
filter, 13, 15 
flow 

in the, 17 
not in the, 19 

  
gateway, 18 
goggles. See list windows 
grammar check, 24 
Graphic_in, 29 
group name, 9 

  
knock the reporter on the head, 7 
  
Layout Desk, 10 
layout-driven workflow, 18 
list view selector, 13 
list window 

change settings, 15 
exercise, 12 

list windows, 6, 11 
logging in, 9 
logging off, 10 
  
Macro tags, 23 
mandatory fields, 21 
mapword, 10, 26 
marginalia, 23 
Microsoft Word, 22 
minus (-), 11 
  
nerds, 7 
notes, 25 
notify buttons, 11, 12 

add or remove, 11 
  
Otto, 29 
  
paragraph tags, 23 
password, 9 
Photo Pool, 29 
Photo_in, 29 
plus (+), 11 
product, 10 
prompt, 16 
ProofView, 24 
PubDate, 10 
  
Ramen noodles, 5 
Remote Input, 29 
revision marks, 11, 21 
Rewrite, 31 
right clicking, 11 
  
Save, 26 
SAVE, 29 
Save Public, 26 
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scroll bar, vertical, 13 
send a story, 26 
Set Login Info box, 10 
Slot Editor, 17 
sort, 13 
Source editor, 6, 17 
spelling check, 24 
spider hole. See user basket 
spreadsheet, 7 
stair-step symbol, 14 
states, 19 
  
tags, 22, 23 
text filter. See filter 
tidbit, 7, 9, 11, 13, 18, 21 
tilde (~), 11, 14 
time stamp, 12 

Triple-I, 5 
  
untagging, 23 
user basket, 14 
User Basket, 19 
  
vetical scroll bar, 13 
  
WebAccess, 29 
wild card. See asterisk 
wire category, 13, 27 
wires, 19 
Work Basket, 17 
work defaults, 15 
work settings, 10 
  
Zone, 10 

 

The News-Sentinel Guide to CCI: An Introduction   Page 29  


